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Handleiding: Pagina's scannen en importeren met

Fiery JobMaster

Overzicht van de functies

Fiery JobMaster biedt de mogelijkheid om
gescande pagina's te importeren met een TWAIN-
compatibele scanner of met Fiery Remote Scan,
naast het importeren van eerder gescande pagina's
in PDF- of afbeeldingsbestandsindeling.

Het samenvoegen van gescande documenten met
bestaande elektronische documenten spaart tijd en
kosten voor het opnieuw maken van het document in
de oorspronkelijke toepassing. Door scans te
importeren met JobMaster kunt u functies voor
afbeeldingen opschonen en rechtzetten voor een fraai
uiterlijk van uw document.

Zodra de gescande pagina's zijn ingevoegd in

Fiery JobMaster, kunnen gebruikers deze verder
bijwerken zonder Fiery JobMaster te sluiten. Dit is
mogelijk door integratie in toepassingen waarmee
afbeeldingen kunnen worden bewerkt, zoals Microsoft
Paint, Preview on Mac, Adobe Photoshop en GIMP,
zodat u verdere bewerkingen kunt toepassen,

zoals bewegende objecten rondom de pagina, tekst
toevoegen en andere bewerkingsfuncties die worden
ondersteund door de gekozen afbeeldingseditor.

Doelstellingen

= Een nieuwe taak maken in JobMaster en een
gescande afbeelding invoegen

« Gescande afbeeldingen en PDF-bestanden
importeren en invoegen

0 Gescande afbeeldingen bewerken en
opschonen

0 Gebruik de hulpmiddelen Brightness
(Helderheid), Contrast, Sharpness
(Scherpte)

0 Deskew (Rechtzetten), Despeckle
(Vlekken verwijderen), Rotate (Roteren)
en Crop (Bijsnijden)

Aanvullende bronnen

Ga voor aanvullende softwaredownloads,
trainingsbronnen en meer naar Fiery Online
Resources. Raadpleeg het document:

Scan and edit pages with Fiery JobMaster

(Pagina's scannen en bewerken) voor meer
informatie.

Voordat u begint

Open Fiery Command WorkStation® 6.2 of
hoger en maak verbinding met een Fiery-server
met Fiery FS300 Pro die Fiery JobMaster
ondersteunt.

o0 Ga voor de bijgewerkte lijst met
ondersteunde printers naar
www.efi.com/Fiery JobMaster

Ga voor het aanvragen van de gratis
proefperiode van 30 dagen van

Fiery JobMaster naar:
http://fiery.efi.com/JobMaster/freetrial 30

Activeer de Fiery JobMaster-licentie op de
computer waarop Command WorkStation
wordt uitgevoerd.

Zorg ervoor dat de printer en de Fiery-
server zijn gekalibreerd voordat u afdrukt.


http://resources.efi.com/
http://resources.efi.com/
https://www.efi.com/resources/fiery-how-to-guides-and-docs/fiery-fs300-pro-and-fs300/
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Pagina's scannen en importeren

Scanvoorkeuren voor JobMaster instellen

Met de voorkeuren voor gescande inhoud van Fiery JobMaster hebt u de opties om ingevoegde
PDF-documenten te controleren op gescande inhoud. Wanneer gescande inhoud in het document
wordt herkend, worden opties voor het opschonen van de scan aangeboden in het dialoogvenster
Preview and Edit (Voorbeeldweergave en Bewerken).

Uw JobMaster-voorkeuren instellen:

1. Selecteer in de werkbalk van de Command WorkStation-wachtrij GEBLOKKEERD de optie
Nieuwe taak

2. Selecteer in JobMaster Edit > Preferences (Bewerken > Voorkeuren) in de bovenste werkbalk.

3. Selecteer in de linkerkolom JobMaster.

4. Schakel onder Scanned Content (Gescande inhoud) het betreffende vak in als u wilt dat
JobMaster ingevoegde PDF's controleert op gescande inhoud of als u een
waarschuwingsbericht wilt weergeven wanneer gescande inhoud wordt herkend.

N ===}

(P

Chapter Starts

Add chapter start when dragging file into page view

Scanned Content

| Check inserted PDF documents for scanned content
¥ Show scanned content message

Edit Image Application

Default (Paint) -

lLJ Cancel
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Ingevoegde gescande PDF-bestanden

1. Start Fiery JobMaster door in het Command WorkStation-vervolgkeuzemenu File > New Job

(Bestand > Nieuwe taak) te selecteren.

Suspend Snapshots

VFFS200PRO225 - 192.168.11.135

» idle

HELD

PRINTED

ARCHIVED

PROCESSING

PRINTING

Devices

| Virtual Fiery FS200 Pro-6

Fiery Command WorkStation
® ] Idle

PROCESSING FRINTING
Idle Idle
HELD (18)
&, Import @ Print [ Properties... Q Preview.. [} Newlob [ Delete ¥ Calibrate.. #fj Logs [P
Job Status Job Title User Size Pages  Copies
[ Spooled 06_catalog_covers LTR.pdf Admin  BIMB 2 1
[ Spooled FS200_FGS_business_card_SAMPLE-imp.pdf Admin  D5MB 2 8
[ Spooled FS200_FGS_business_card_SAMPLE.pdf Admin  D3MB 2 1
[ Spooled F5200_FGS_handbook variable SAMPLE_LTR.pdf Admin  0IMB 400 1
[™ Spooled Thumbs.db Admin  01ME  Unknown 1
[ Spooled 09_Spring_Show_Invite.pdf Admin  19MB 120 1
[ Spooled 08_Catalog_complete_SAMPLE_LTR.pdf Admin  261ME 85 1

2. Open het vervolgkeuzemenu Insert (Invoegen) op het deelvenster Page View
(Paginaweergave). Selecteer Insert PDF or PS File (PDF- of PS-bestand invoegen).
Er wordt een standaardvenster voor het selecteren van een bestand geopend.

O Fiery JobMaster-Impose - Untitied
File Edt Actions View Help

insent xOFaQQ|l
e neet

Ingert PDF or PS Fde. L}

Inzert Irmage Files.

Insert Server Job

Insert From Scanner...

Insest Blank Sheet Ctrle Shift+5

Inzert Tab »
Sheet 1 - Front
Default Media

Page Size

¥ 216 oo x 279 men (1
Meds Sce

¥ 26 229 mmill

Media Type

E=RECR "%
Template: -
Compose ~
Sheet: Same as Document Size - Edit...
Duplex off -
Cover
Copees: 1
v Scale
Scaling: Do not scale -
Scale Factor:
w Finishing
Fold: on -
Fold order: | Outside =

Hole-punche [0t =
Punch holes: | Default =
Stapling: ot

Set definition: | None
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3. Markeer het voorbeeldbestand Scannedimage.pdf en selecteer Open (Openen).

3 Select  PDF or PS file ==l
O_C) | L+ Ling's demo files » .].,!' ecirch Ling's demo files )
Organize v New folder =~ [l @
I Favorites = Name Date moddied Type Siz

Bl Desktop ka9

8 Downloads \. Bad Duplo sample n
2 Recent Places L Chapters 31
% Google Drive \. Duplo Sample files
L TO-GA L 1200_how_to_bleed_edge _tabs

F5200_How-To up_finish_edge_Sele
w4 Libranies b F5200_How-To_Unique_Numbered Ticke.. 3/1

*| Documents ). Scanned docs 4/3
o Music £ Tl Binderlpar 3/2
= Pictures #5 Fiery_FS150_Pro_Product_Guide LTR.pdf 471
H videos 1 F5150 Product Guide.pdf 571

& F5200_FGS_NCR_form_LTR.pdf
1™ Computer % one POF.pdf
& Local Disk (C)

¥4 DVD RW Drive (0-) TF Prep 41.0
W4 CD Drive (E)
% MRD Sample Files on MacBook Pro

| Size: 185 MB
| Date modified: 5/5/2018 11:12 AM

i Network

-« m

File name: Scannedimage.pdf - |_PDF File (*.pdf)

4. Selecteer Yes (Ja) in het dialoogvenster Scanned Content (Gescande inhoud) om deze
afbeeldingen te controleren en bewerken. Fiery JobMaster herkent automatisch welke pagina's
gescand zijn, en opent het venster Preview & Edit (Voorbeeldweergave en bewerken).

bl

Scanned Content

This document includes scanned content. Would you like to
review and edit these images first?

_D Do not check for scanned content
[7] Always edit scanned content and don't show this message again

ey ) he
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5. Selecteer Deskew (Rechtzetten) en kies On (Aan). Als u de pagina-instelling Deskew
(Rechtzetten) wilt toepassen op alle pagina's in de scan, selecteert u Apply to all (Overal
toepassen). Na het maken van algemene wijzigingen voor alle pagina's kunt u doorgaan met het
corrigeren van afzonderlijke pagina's. Gebruik de pijlen vooruit en achteruit om door de
pagina's te bladeren.

IS ) Preview & Edit
AT A AT e - LS & Q
Brightness:
: @ s O- |0
{ {{: Ea o Contrast:
m_._u,,.l'.’,.?_\_.m T O @ o

Restore to Original
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6. Ook al wordt door het selecteren van Deskew (Rechtzetten) de gescande pagina automatisch
zo wordt geroteerd dat de uitlijning horizontaal parallel is aan de doelpagina, kan het zijn dat voor
sommige pagina's kleine aanpassingen aan de hoek moeten worden gedaan. Gebruik de
schuifbalk Fine Rotation (Fijne rotatie) om de correctie door te voeren.

0O 0 oo

Contrast:

= 1 ‘s12a
PP i e e ...: Onentation:
Bi
» Width: Height:
21589 mm 2794 mm
[=] H 4 12 » W 52 100% -
[ Restoreto Original | | Appiytoail | [ Done || conce

7. Selecteer Done (Gereed) om de functie Preview & Edit (Voorbeeldweergave en bewerken)
te sluiten en automatisch het venster Insert Pages (Pagina's invoeren) te openen.



Handleiding: Pagina's scannen en importeren met Fiery JobMaster e @

8. De gecorrigeerde pagina's worden weergegeven. Klik op het selectievak Select All
(Alles selecteren) om alle pagina's te kiezen. Selecteer in het gedeelte Insert (Invoegen)
After Page (Na pagina) en stel het paginanummer in op 1. Klik op de knop Insert (Invoegen).

O Fiery JobMaster-Impose - Untitled

xoFaaq|

Temgplate: |
Insert Pages @ Compote + |
File: C\Users\efi\AppData’\Local\Temp\IMP3P]-16331854 b250\scanpdfl. paf Browse... Sheet: Same-;
Duplex off |
1 -
Copies: 1
w Scale I
T 2 Scaling: Dond
Scale Factor: |
w Finishing |
Fold: Off |

Fold order: | Qutsie
Hole-punch: | Off |

Punch holes: 'De\‘lu._

Stapling:  |Off |
7] Sek —3
Set definition: | None|
Insert | Afper Page = 1 Insent [}
= i) Select the pages you want and drag them onto the left pane. Close
age Size You can also select multiple pages by holding ‘Shift’ or 'Ctrl’ keys.
4 mm x 279 m
Media Size
¥ 206 mmx 279 mm (11

Media Type -

De nieuwe inhoud wordt na de voorpagina ingevoegd.

Het bijgewerkte document kan verder worden bewerkt door inslag- of vel-instellingen toe te voegen in
Impose en de instellingen in Job Properties (Taakeigenschappen) te voltooien.
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Afbeeldingsbestanden invoegen

1. Selecteer op de Command WorkStation-werkbalk File > New Job (Bestand > Nieuwe taak).
Selecteer Insert > Insert Image Files (Invoegen > Afbeeldingsbestanden invoegen).

© Fiery Command WorkStation
File Edit Act €] Fiery JobMaster-Impose - Untitled

File Edit Actions
DixdFaq|B|d]

Ctrl+Shift+P

View Help

Create §

neet

Insert Image Files... %
Insert Server Job...

Insert From Scanner...

Insert Blank Sheet

Ctrl+5Shift+5
Insert Tab 3

2. Zoek en markeer de afbeeldingsbestanden Scannedimage-1.png en Scannedimage-2.png en
selecteer Open (Openen). De Fiery-server herkent automatisch dat dit een gescande afbeelding
is en opent de functie Preview & Edit (Voorbeeldweergave en bewerken).

1D Fesy JobMuster-bnpose - Unteled = @3
O seectmage i =
G\ =/ b+ Ung's demofiles » v |6 ] ze ‘ ) =

Ovganize = Hew fobder » 0, @ jis=
- Fovorik Same a3 Document Sae - Eda.
reontes
BE Deiktop &5 ol =z
& Devenioads Ead Duglo sample
| Recent Places Chapters
#7 Google Diive Duplo Sample files -
TO-G4 F4200_hew_to_bleed_edge_ tabs
0, Hewe T angup, f Do mot scabe -
A Libraries F5200 How-To_Unique_Numbered_Ticke_. _ %
% Decuments Scanned docs
o Music »
i Pictures B Scunnedimage-1 LLi] )
B viceos By Scannedimage-2 Outude =
o~
1% Computer
& Locsl Disk (€ Defavit
%4 DVD RW Drive (D) TF Prep 410 o »

d €O Deve [E:) el =
Lg% MRD Sanple Files en MacBock Pro

= |Image Fies (*bemes *.git " jpeg ¥

[Copm ] | comea
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3. Sommige afbeeldingen moeten mogelijk worden bewerkt voordat ze in de taak kunnen worden
ingevoegd. Hulpmiddelen voor Preview & Edit (Voorbeeldweergave en bewerken) zijn onder
andere Brightness (Helderheid), Contrast, Sharpness (Scherpte), Deskew (Rechtzetten),
Despeckle (Viekken verwijderen) en Fine Rotate (Fijne rotatie). Raadpleeg het gedeelte
"Gescande PDF-bestanden invoegen" stap 5-8 voor instructies voor het opschonen van scans.

Insert from Scanner (Invoegen vanuit scanner):

Met de functie Insert from Scanner (Invoegen vanuit scanner) kunt u scans starten vanaf het
printerglasplaat, een automatische documentvoeding (ADF) of een TWAIN-compatibele scanner.

1. Selecteer op de Command WorkStation-werkbalk New Job (Nieuwe taak).

Selecteer Insert (Invoegen) en kies in het vervolgkeuzemenu Insert From Scanner
(Invoegen vanuit scanner).

2. Kies Fiery Remote Scan in de lijst van scanners als deze niet is geselecteerd en klik op
Scan (Scannen). U kunt een andere scanner selecteren als de TWAIN-invoegtoepassing van
deze scanner op uw computer is geinstalleerd.

Scan X
Scanner:
Fiery Remote Scan v
Scan Cancel

10
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3. Kiik op het pictogram voor het kiezen van een Fiery (vergrootglas) om het dialoogvenster

Connector to Server (Verbinding maken met server) te openen.

Fiery Server:
FieryColor1

Mailbox:

Name

Pages

FROM MAILBOX

Size

Change Mailbox...

Date & Time ¥

Close

11
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4. Kies een van de volgende mogelijkheden om een Fiery-server te zoeken:
i. Selecteer Auto Search (Automatisch zoeken).

ii. Selecteer IP-bereik of Subnet om een bereik op te geven waarin u wilt zoeken.
5. Klik op Start. Filter de weergegeven resultaten op trefwoord.

e © Search

Search: From To

IP Range H 10 . 101.16 .45 10 . 101.16 .50 Go
Search Results: A

Filter by keyword:

Name Device Name IP Address

Cancel

6. Kilik op Add (Toevoegen) en kies een van de volgende mogelijkheden:

i. Als u de server wilt toevoegen en er verbinding mee wilt maken, klikt u op
Connect (Verbinden).

Als u de server wilt toevoegen zonder er verbinding mee te maken, klikt u op het
pictogram met het plusteken.

e ) Connect to Server
My Fiery List:

FieryColorl
ﬂ FieryLimo

Connect to a server:

(Server name or IP address)

Cancel

12
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7. Me Fiery Remote Scan kunt u scans starten van de glasplaat van de printer of een automatische
documentinvoer (ADF). U kunt ook scanbestanden openen die zijn opgeslagen in een postvak.
Selecteer from MAILBOX (Vanuit Postvak IN) of SCAN (Scannen) Als u SCAN (Scannen)
kiest, selecteert u uw scanvoorkeuren en selecteert u de knop Scan (Scannen).

Fiery Remote Scan X Fiery Remote Scan
Fiery Server: Fiery Server:
FDMA-NX v Q FDMA-NX vl Q
FROM MAILBOX SCAN FROM MAILBOX “
Mailbox: Source:
Change Mailbes... Platen i
Name Pages Size Date & Time ¥ Size: Resolution:
Auto Detect ~ | | 300 dpi ~
Sides to scan:
Single-Sided
Color Mode:
@ Color (O Grayscale (O Black and White
< >
@ Acquire Close @ Scan Close
8. Selecteer uw scanopties en selecteer Scan (Scannen).
® Fiery Remots Scan [@ Fiary Ramote Scan ) Fiary Ramote Scan
Fiary Server: Fiary Sorver: Fiary Server:
FhoryColer! Ba FiaryCoior1 Ba FiaryColor1 Ba
o I — v [N
Source: Source: Source:
Plsten B Platen B Plsten B
P hosctution: Size: hescution: sae. Resolution:
Auto Detect J_poodoi -] Auto Detect B |00 [~ ] uta Detect 300 dpi B
821 600 dpi
Sides ta scan: aitanl Sdes 1o scan: 400 dpi
11x17
Al 150 dpi
Color Mode: nas Color Mode:
O Color ) Grayscale | Black and White ™ Hack and White O Color ) Grayscale
a1a
as
8s-R
B4
Close Scan Close Scan Close Scan

9. Na het voltooien van het scannen wordt het dialoogvenster Preview and Edit

(Voorbeeldweergave en Bewerken) geopend. Gebruik de opties in het venster Scan Preview &
Edit (Scanvoorbeeld en scan bewerken). Deze opties zijn beschikbaar voor afzonderlijke
pagina's of, als de knop Apply to all (Overal toepassen) is geselecteerd, voor alle pagina's van
de scantaak: Opmerking: Het is ook mogelijk om bijkomende pagina's te scannen en aan de
bestaande scantaak toe te voegen. Raadpleeg het gedeelte "Gescande PDF-bestanden
invoegen" pagina 6-7 voor instructies voor het opschonen van scans.

13
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Ga voor meer informatie en instructies over de configuratie van Fiery Remote Scan naar www.efi.com

Ga voor aanvullende softwaredownloads, trainingsbronnen en meer naar Fiery Online Resources.

14


http://resources.efi.com/

EFI fuels success.

We develop breakthrough technologies for the manufacturing of signage, packaging,

textiles, ceramic tiles, and personalized documents, with a wide range of printers,

inks, digital front ends, and a comprehensive business and production workflow suite

that transforms and streamlines the entire production process, increasing your

competitiveness and boosting productivity. Visit www.efi.com or call 650-357-3500 s
for more information. ef 7
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Nothing herein should be construed as a warranty in addition to the express warranty statement provided with EFI products and services.
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